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 FSM30X  
Quick Start Guide with Nucleo  

 
 

1. Hardware	

1.1. Introduction	
 

The FSM30X is a compact IMU module based on CEVA's Hillcrest Labs business unit’s BNO080 9-axis SiP. 
The FSM30X incorporates the BNO080, a 32.768 kHz crystal and passive components into a compact 
module form factor that can be quickly and easily integrated into a design. The FSM30X provides all the 
motion based outputs available on the BNO080. It does not support environmental sensors. 

 

Figure 1: FSM30X 

1.2. Connections	with	Nucleo	
 

The FSM30X uses the Sensor Hub Transport Protocol (SHTP) to communicate with a system or 
application processor (host that connects to the FSM30X). The SHTP protocol is documented in the 
BNO080 Datasheet [1], allowing a customer to potentially develop their own host software if they 
choose to do so. In order to ease customer integration, Hillcrest has developed software that runs on a 
host platform such as the STM32F4x1RE Nucleo series. The software driver fully implements the 
communication protocol used by the FSM30X. Hillcrest provides this software driver package as source 
code. 

Please refer to Hillcrest FSM30X Datasheet [4] and FSM300 Connection with Nucleo [5] for more 
information on the pinout and connection.  
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Figure 2: FSM30X Pinout 

Customers who intend to use the FSM30X for their own software development should purchase 
STM32F4x1RE Nucleo series separately. There are two options to evaluate the FSM30X modules, which 
will be explained in detail in the next section. 

 

Figure 3: FSM30X connected to STM32F411RE Nucleo Board (I2C mode shown) 
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2. Software	

2.1. FSM30X	with	STM32	Nucleo	Board	Running	a	PC	Demo	Application	
 

Customers can download STM32 Nucleo board image with Hillcrest software that allows communication 
between the FSM30X and Freespace® MotionStudio 2.  

Freespace® MotionStudio 2 is a Windows application to allow users to control and configure the 
FSM30X through a USB interface. This approach can be used for a quick evaluation of the FSM30X. A 
generalized system diagram is shown in Figure 4. 

 

 

  

 

 

Figure 4: Simplified System Diagram with Freespace® MotionStudio 2 

 

2.1.1. Program	STM32F4	Nucleo	Board	with	the	Bridge	Binary	
Download Nucleo Bridge Binary from https://www.hillcrestlabs.com/downloads/bridge-firmware-for-
nucleo. 

Program STM32 Nucleo board you purchased with the bridge image: 

• Open STM32 ST-LINK Utility. 
• Target->Connect. 
• Target->Program. 
• In new window select “File path” to locate the file you just downloaded. 
• Click “Start”. 
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Figure 5: STM32 ST-LINK Utility Window 

2.1.2. Other	Requirements	
Running Freespace® MotionStudio 2 with FSM30X requires the following items. 

• ST-LINK/V2 USB driver available from the ST website (http://www.st.com/en/embedded-
software/stsw-link009.html). 

•  ST32 Virtual COM Port Driver from ST website (http://www.st.com/en/development-
tools/stsw-stm32102.html). The FSM30X software package is tested with STSW version 1.4.0. 
Once you have downloaded and extracted the driver, follow the readme.txt file for the 
instruction to complete the installation. 

• Freespace® MotionStudio 2 application from 
https://www.hillcrestlabs.com/downloads/freespace-motionstudio-2. 

Connect USB Type A to Mini-B cable to Nucleo board and your PC. The virtual COM port should appear 
in your Device Manager. 

 

Figure 6: Device Manager to Check Installed Driver for ST Virtual COM Port 
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Start Freespace® MotionStudio 2 (MotionStudio2.exe) after STM32 Nucleo virtual COM port is 
successfully detected in your PC. 

2.1.3. Running	PC	Application	

Start	Freespace®	MotionStudio	2	
After you unzip the PC Application package, launch MotionStudio2.exe under MotionStudio2 folder. This 
will open MotionStudio2 window.  

 

Figure 7: Startup Window of Freespace® MotionStudio 2 

Establish	Connection	to	the	Nucleo	Board	
From the menu panel on the left, select Device Connection. This panel allows users to select device type, 
transport protocol and more.  

• “Device Type” of the bridge is set to ST Nucleo. 
• ST Link Virtual COM Port available in your PC appears in “Virtual COM Port” box. 
• “Target Device” is set to SHTP over I2C by default. Follow the instruction in the Application Note 

- FSM300 Connection with Nucleo [5] Section I2C. Please note that Freespace® Motion Studio 2 
currently supports SHTP over I2C and SHTP over SPI interface. 

• Use “Connect” button to start. 
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Figure 8: Device Connection Panel in Freespace® MotionStudio 2 

 

 

Figure 9: Device Connection Window after Successful Communication in Freespace® MotionStudio 2 

When connection process is completed, the three status indicator text boxes on the upper right hand 
corner of the panel and the console window on the bottom would provide the result of connection 
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process. The three status indicators show the status of the connected system and the status of the 
associated panel. If the specific panel supports the protocol used by the connected device, the panel 
becomes active and shows in green color. 

 

Sensor	Control	
The Sensor Control panel allows the users to enable and disable the various sensors individually. There 
are two ways to control sensors: 

• To enable an individual sensor at a default operation rate, use the check box on the right end of 
the row for each sensor.  

• To enable sensors at specific rates, input the requested operation period, in microseconds, in 
the 'Requested Period (us)" fields. Then click the "Set Sensor Periods" button on the top of the 
panel. All sensors will be updated with specified operating period. The "Requested Period (us)" 
fields which are left blanked or obtained invalid value are assumed to be "zero". 

In many cases, the sensors do not operate at the exact rate as requested. The actual operating period is 
shown in the "Reported Period (us)" field. Users can also use the "Get Sensor Periods" button on top of 
the panel to refresh the actual operating period for all sensors. 

 

 

Figure 10: Sensor Control Panel in Freespace® MotionStudio 2 
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Virtual	Object	
Virtual Object panel shows the orientation of the device. Please note that you need to enable sensors in 
Sensor Control panel, select the sensor from the drop-down menu in Virtual Object panel. The sword in 
the Virtual Object will move to the device orientation. 

To adjust the camera position, move the cursor to the Virtual Object Panel, then press the LEFT mouse 
button. Hold the button down and move the mouse to change the view position. To reset the camera 
position, use the "Reset Camera Position" button.  

To display the game rotation vectors, select the game rotation vectors from the drop-down menu, the 
data fields should start updating with the received sensor data. The virtual object will move to the 
orientation of the hardware. Use the Sensor Control Panel to enable or disable the specific sensor. This 
panel does not control the sensor but displays the output data. 

 

 

Figure 11: Virtual Object Panel in Freespace® MotionStudio 2 
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Figure 12: FSM30X Orientation 

 

Please follow the instruction below to align your device.  

• Enable Game Rotation Vector and ARVR Stabilized Game Rotation Vector in “Sensor 
Control” panel.  

• Switch to Virtual Object panel and move the background so the black corner of the Hillcrest 
logo on the ground plane points to your forward direction (heading).  

• Hold the FSM30X module Y+ axis points to your forward direction as well.  
• Select “Game Rotation Vector” in drop down menu and click “Tare Z”. Now, sword will point 

to the edge of the Hillcrest logo and is aligned with your device Y+. 
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• Switch to “ARVR Stabilized Game Rotation Vector” in drop down menu to evaluated ARVR 
Stabilized Game Rotation Vector. 

 

 

Figure 13: Sensor Orientation in Virtual Object Panel in Freespace® MotionStudio 2 

 

2.2. FSM30X	with	STM32	Nucleo	Board	in	Development	Environment	
 

The example software requires the following items to execute. 

• IAR Embedded Workbench® for ARM (EWARM) by IAR Systems. 
• ST-LINK/V2 USB driver. This driver is available from the ST website and is supported by the IAR 

Embedded Workbench for ARM (EWARM). After installing EWARM, check 
IAR_INSTALL_DIRECTORY\arm\drivers\ST-Link\ directory. Please skip this step if you have 
installed already from Section 2.1.2. 

• ST32 Virtual COM Port Driver from the ST website. Please skip this if you have installed already 
from Section 2.1.2. 
 

 

Figure 14: Installed driver for ST Virtual COM port 
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• Terminal emulator software like Tera Term or PuTTy. Set up the terminal emulator at 115200 – 
8bit – no parity – 1bit stop bit – no flow control. 

2.3. FSM30X	with	STM32	Nucleo	Board	Running	Example	Application	
 

Hillcrest provides a complete software package for the STM32F4x1RE Nucleo boards.  

The example application for the FSM30X source code is available in public github.  

https://github.com/hcrest/bno080-nucleo-demo 

Clone this repository using the --recursive flag with git.  Alternatively, you can download a ZIP file from 
the link. 

git clone --recursive https://github.com/hcrest/bno080-nucleo-demo.git 

Everything required to obtain outputs from the FSM30X is included in this package. The software 
package incorporates the FSM30X sensor hub driver, enabling SH2 functionality for the development 
system. 

 

 

 

 

 

 

Figure 15: Simplified System Diagram (blue indicates driver developed by Hillcrest) 

 

 

Figure 16: Source Code Structure  
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The software is organized as an IAR EWARM project that can be dropped into the IAR IDE on a Windows 
PC.  Follow this procedure to compile the project and download the software to the Nucleo board. 

• Open IAR Embedded Workbench for ARM (EWARM). 
• In the File menu, select Open and choose Workspace. Browse to where the example package is 

extracted and select “sh2-example-nucleo/EWARM/Project.eww”. This should open an IAR 
workspace with all the files within the project. 

• Select one of sh2-demo-i2c, sh2-demo-spi, sh2-demo-uart or demo-rvc in the project 
configuration based on the board connection. Refer the information in the Application Note - 
FSM300 Connection with Nucleo [5]. Please note that all 4 protocols are supported in MCU 
workspace.  

• In the “Project” menu, select “Rebuild All” to compile the project. 
• After the project is successfully compiled, go to the Project menu and select Download and 

Debug.  

 

The “sh2” directory contains a full implementation of the Hillcrest communications protocol for the 
BNO080 and User’s Guide for Hillcrest’s SH-2 driver. 

The reader is encouraged to review the BNO080 datasheet [1] and the SH-2 Reference Manual [2] for 
details on how to construct messages. 

The output from the FSM30X is printed through the serial port. The first few lines indicate that the host 
has established proper communication (“Product ID Request”) with the BNO080 and the BNO080 has 
responded with version information (“Product ID Response”). 

Rotation vector is enabled at 100Hz by default and reports are printed through the serial port.  

 

Figure 17: Terminal Emulator Screenshot 
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Figure 18: IAR EWARM Screenshot 
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Notices	
© Copyright 09/2019 CEVA, Inc. and/or its subsidiaries (“CEVA”) All rights reserved. All specifications are 
subject to change without notice. 

Freespace is a registered trademark of CEVA. Other company and product names mentioned in this 
document may be the trademark or registered trademark of their respective owners. 

Disclaimer: The information furnished herein is believed to be accurate and reliable. However, the 
information is provided “AS IS”, without any express or implied warranty of any kind including warranties 
of merchantability, non-infringement of intellectual property, or fitness for any particular purpose.  

In no event shall CEVA or its suppliers be liable for any claims and/or damages whatsoever arising out of 
the use of or inability to use the materials. CEVA and its suppliers further do not warrant the accuracy or 
completeness of the information, text, graphics or other items contained within these materials. CEVA 
may make changes to these materials, or to the products described within.  
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